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PREFACE

Volume 1, Hardware Environment, contains system configuration and system-level processing information for the
ETS HRS, developed by the Microelectronic Systems Branch, Code 521, NASA/Goddard Space Flight Center
(GSFC). Volume 1 explains how the system operates, the functions it performs, appropriate applications, and
installation/operational procedures.

This document, Volume 2 , describes the ETS HRS telemetry processing control environment (TPCE), and how to
use TPCE to monitor and control telemetry processing sessions.

User should pay attention to Section 1 - System Constraints before reactivating TPCE.

This document is under the configuration management of the Microelectronic Systems Branch Configuration
Control Board (CCB). Changes to this document shall be made by Documentation Change Notice (DCN),
reflected in text by change bars, or by complete revision.

Requests for copies of this document, along with questions or proposed changes, should be addressed to:

Technology Support Office

Code 520

Goddard Space Flight Center

Greenbelt, Maryland 20771
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General Information

1
This section describes the general information about telemetry processing
control environment (TPCE) and ETS HRS System Overview.

1.1 Introduction

This document provides the procedures used to operate and maintain the ETS HRS. Development of the system is
a joint effort between NASA/Goddard Space Flight Center (GSFC) Codes 521 and 522. Code 521, the
Microelectronic Systems Branch, designed the custom hardware and software for the system; Code 522, the
Software and Automation System Branch, designed and developed the Telemetry Processing Control Environment
(TPCE), which is the operator interface software that provides tools for controlling and monitoring operation of
the ETS HRS.

The ETS HRS may also be controlled and monitored via the Code 521-developed Operations Manager (OPMAN)
program. This user interface software runs on a VT-100 (or equivalent) terminal, and can be used to access system
information in the event of a network failure. The ETS HRS User Guide (Volume 1) provides procedures and
information specific to the OPMAN interface.

1.2 TPCE Overview
TPCE allows an operator to set up the ETS HRS, flow data through the system, and monitor system status from a
remote (or local) location that is connected through Ethernet. TPCE runs on an HP-755 workstation using X-
windows.

TPCE receives and sends setup, status, and data through the Master Controller of the ETS HRS. Information is
passed between the two systems packed in Modular Environment for Data Systems (MEDS) messages, which
provide the translation of information in a format that ETS HRS can process and produce. TPCE translates input
from the ETS HRS, and creates displays and updates screens accordingly. It also receives commands and data
from the operator, and transfers that information to the ETS HRS.

TPCE is a menu-driven window system. Multiple windows can be open, which provides the operator with a
versatile and efficient method to access information, monitor status, and perform tasks. Windows may be
opened/closed as needed, screen positions may be changed, and screens may be closed into icons.

Using TPCE to control the ETS HRS will allow the operator to:

• Establish a connection between a TPCE workstation and the ETS HRS (MEDS-based system). TPCE
provides a list of all available MEDS-based systems and whether TPCE is connected to each system.
From this list, the operator may connect or disconnect to the ETS HRS.

• Load a previously edited catalog. A new catalog can also be created. TPCE allows MEDS catalogs to be
created, deleted, modified, and saved. Once a catalog is created, it is maintained in a hierarchical
directory, which the operator accesses to manipulate catalogs.
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• Enable the ETS HRS in preparation for a processing session.

• Access status screens and monitor telemetry processing. Status collection can be automatic, or in
response to a command sent by the operator.

• End the processing session. Two TPCE commands are used to end an acquisition session: Flush releases
any residual data from subsystem buffers, and Disable turns off data flow and processing. These
commands can be initiated automatically by detection of a timeout condition.

• Manage data set distribution by issuing data set transfer commands to the Versa Module Eurocard (VME)
system based on a request table, and data set ready events received from the VME system.

WARNING:   HRS is required to complete a warm boot no longer that 10 minutes.  When you exit from TPCE,
system is gracefully shutting down all opening processes and network sockets.  It is necessary that you wait for at
least 60 seconds before bring up TPCE again after a graceful shutdown.

1.3 System Overview

1.3.1 Purpose of ETS HRS

The ETS High Rate System (HRS) consists of the VME High-rate Subsystem (VHS), the Tape Recording
Subsystem (TRS) and the Control and Display Subsystem (CDS).  Together, these three subsystems will support
tests for EOSDIS return link science data processing functions.  In specific, the VHS will provide the following
major functions:

• Transmit two channels of simulated TGT return link data and clock using ETS generated and/or user
provided test data at user-selectable rates up to 150 Mbps each.

• Transmit data sets to an external destination through EBnet interface at rates up to 34 Mbps.

• Receive data sets from an external source through EBnet interface at rates up to 34 Mbps.

• Accept SCITF generated spacecraft test data on AMPEX tape media.

• Process SCITF generated spacecraft test data to generate EDOS-compatible Expedited Data Set
(EDS) and Production Data Set (PDS).

Despite its specific design, the system includes many additional capabilities. Figure 1-1 illustrates an example
operational configuration for ETS HRS.
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Figure 1-1. ETS HRS Configuration Overview
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1.3.2 System Signal Flow
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Figure 1-2. ETS HRS Data Flow Diagram
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Operational Scenarios

2
This section describes the Operational Scenarios in which the ETS
HRS system will be used.  The section will describe the two modes
of operations, namely the ETS Operations Mode and the ETS Off-
line Mode.  The Off-line Mode is used to create the simulated data
and stage it for the Operations Mode.
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2.1 ETS Operations mode

The ETS Operations Mode (referred to as the Big Disk mode) is defined as the mode in which the ETS HRS is
used to test the interfaces to and from EDOS as described in the ETS HRS System Requirements document.  This
mode will essentially test the configurations described in the following paragraphs.  The procedures for testing
these configurations are also outlined in the following paragraphs, and the details on how the each sub-system
within these test configurations is set-up are described the later sections of the document.

In the Operations Mode, a limited number of cards or sub-systems that are active on the ETS HRS VME Rack.
This ensures the least amount of traffic on the VME back-plane to achieve the high data rets expected of the VME
system.  The cards that are active in this mode are:

Master Controller

Simulator Card

Data Set Processor Card

These cards are configured using catalogs with the required information.  The process of loading a catalog may be
accomplished by either using the local control terminal running OPMAN, or by using the CDS running TPCE.
The TRS is configured to run controlled by the TRS GUI residing on the CDS.

2.1.1 Data Sets Transfer from ETS HRS via EBnet

The following sequence of steps will implement the transfer of data sets resident on the Ciprico Disk Array using
FTP over the FDDI interface via EBnet to the DAACs.  The data sets have to be previously stored on the disk
array.  The configuration shown in Figure 2-1 shows the active elements in the data set transfer.

1. Ensure the system in the “BIG-DISK” mode

2. From the UI select the display page for FILE TRANSFER (under OPMAN it is FD Status).

3. In the FILE TRANSFER page, select the file and the destination (under OPMAN select the Commands
option from the set of options displayed at the bottom of the displayed page)

4. In the FILE TRANSFER page, select the command to SEND the data (under OPMAN, in the commands
list, select the File Transfer command)
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Figure 2-1. ETS HRS Simulating Data Sets Transfer to DAACs

5. (Under OPMAN, from the displayed page select the Browse option for the session under review)

6. (Under OPMAN, from the file listing, select the specific file for transfer and enter the destination for the file)

7. (Under OPMAN, for the displayed file select the Send option to send the file out on EBnet)

8. Read the status on the FILE TRANSFER status page  (under OPMAN monitor the status on the FD Status
Page).

2.1.2 Data Sets Receipt on ETS HRS via EBnet

The following sequence of steps will implement the FTP receipt of data sets to the Ciprico Disk Array over the
FDDI interface via EBnet from EDOS.  The data sets will be stored on the disk array.  The configuration shown in
Figure 2-2 shows the active elements in the data set receipt.

1. Ensure that the system in the “BIG-DISK” mode.

2. Ensure that the FTP daemon is running on the ETS VHS.

3. From the UI select the display page for FILE TRANSFER (under OPMAN it is FD Status).

NOTE:  In the test environment, to test the FDDI interface into the system, the FDDI connector from the CDS is
connected to the DSP.  A FTP command issued on the CDS UNIX window will transfer a specified file from the
CDS local disk to the Ciprico Disk Array.
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Figure 2-2. ETS HRS Simulating Data Set Receipt from EDOS

2.1.3 Return Link Telemetry Data Stream from ETS HRS to 
EDOS

The following sequence of steps will implement the simulated TGT return-link data streams to EDOS.  There are
two simulated streams that are sent to EDOS.  One stream is simulated using the ETS VHS and the other stream is
simulated using the ETS TRS.  The simulated data, which in this case are CADUs are created using SCTGEN.

2.1.3.1 ETS VHS Simulated Return-Link Data Stream

In this implementation of the return link data stream, the CADU test data is generated by SCTGEN in the form of
a ‘base’ and ‘update’ file.  The ‘base’ file is loaded on to the Simulator card using a catalog.  The update file is
previously loaded in to the system disk on the ETS VHS.  When the serial data stream is simulated, the CADU
data is output via the front ECL data and clock output terminals on the Simulator Card.  Figure 2-3 shows the
active elements in the ETS VHS simulation of a TGT return link data stream.

1. Ensure that the system in the “BIG-DISK” mode

2. To set-up, from the UI select the Load or Edit option

3. If Edit is selected, type in the name of the catalog to be loaded and edited

4. The opened catalog will display only one set-up page that is editable, i.e. the SX set-up page

5. After re-editing the catalog, the option to Save and/or Activate is used to run the catalog

6. If Load is selected, type in the name of the file to be loaded, and Enable the catalog
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7. The status of the CADU data transfer is monitored on the SX status page.
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Master 
Controller
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Figure 2-3. ETS VHS Return-Link Simulation

2.1.3.2 ETS TRS Simulated Return-Link Data Stream

In this implementation of the return link data stream, the CADU test data is generated by SCTGEN in the form of
a ‘plain’ file.  The plain file is previously recorded on to a SONY tape on the TRS.  The ETS TRS GUI is opened
from the CDS, and the file name selected form the listed directory on the SONY tape.  When the serial data
stream is simulated, the CADU data is output via the SONY data and clock output terminals on the Switch Panel
on the ETS TRS.  Figure 2-4 shows the active elements in the ETS TRS simulation of a TGT return link data
stream.

CDS 
Workstation

Triplex 
Interface

Clock 
Generator

Cmnds/Status

ETS Tape Recording System

SONY Tape 
Drive

EDOS

150 Mbps CADU 
Bitstream

Figure 2-4. ETS TRS Return-Link Simulation
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1. Bring up the ETS TRS Graphical User Interface using the UI on the CDS.

2. On the switch panel for the TRS, set the Clock generator to the TRIPLEX mode, the SONY DATA and
CLOCK output to the EXT mode.

3. On the Clock Generator control panel, recall a preset value for frequency and ECL levels, or set ECL
levels and the frequency for data rate output..

4. Using the PLAYBACK mode for the SONY, select the SONY tape and specific file on the tape to be
output and depress the PLAY icon on the GUI.

5. The status of the CADU data transfer is monitored on the ETS TRS GUI display page for the SONY.

2.2 ETS OffLine Mode

This mode is used to generate test data prior to the running of any actual tests.  The test data may be return-link
data using SCTGEN, data sets using SCTGEN or the ETS VHS.  In this mode the ETS VHS will be in what is
referred to as the “LZP Mode”.  In this sub-section the generation of these data products will be discussed.

In the Offline Mode, the whole complement of cards or sub-systems are active on the ETS HRS VME Rack.  The
cards that are active in this mode are:

• Master Controller

• Simulator Card

• Frame Synchronizer Card

• Reed-Solomon Card

• Service Processor Card

• Annotation Processor Card

• Data Set Processor Card

These cards are configured using catalogs with the required information.  The process of loading a catalog may be
accomplished by either using the local control terminal running OPMAN, or by using the CDS running TPCE.
The TRS is configured to run controlled by the TRS GUI residing on the CDS.

2.2.1 Generating Simulated Data Sets for Transfer to and
from EDOS

There are two options to create these data sets.  The first option is to use SCTGEN to create the data sets and store
them on a tape media.  Prior to the test configuration for data set transfer from the ETS HRS to EDOS, these data
sets must be transferred from the tape media to the Ciprico Disk Array on the ETS VHS.  The second option is to
input a known return-link data stream into the VHS and perform level-zero processing on the data.  The data sets
are then generated by the ETS VHSand stored, once again, on tape media prior to the configuration to be tested.
These data sets are transferred to the Ciprico Disk Array on the ETS VHS to run the test.
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2.2.1.1 SCTGEN-Created Data Sets

• Create the data sets using SCTGEN, these data sets will be written on to the default device, the CDS.

• Once a data set file is on the CDS, FTP the data set to the ETS VHS Ciprico.

EDS, PDS

30 GB  
Disk Array 

Test Data Sets

CDS 
Workstation 

SCTGEN

ETS VME High-rate System

Data Set 
Processor

Test EDS, 
PDS

Master 
ControllerCmnds/Status

Opman

EDS, PDS

EDS, PDS

Figure 2-5. SCTGEN Small Data Set Generation

• For large data sets, greater than allowable space on the CDS, direct the write device to the SONY via the
Triplex system.

• Once the data sets are created, use the PLAYBACK mode from the TRS to write the data back in to the
CDS a data set file at a time.

• Once a data set file is on the CDS, FTP the data set to the ETS VHS Ciprico
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Figure 2-6. SCTGEN Large Data Set Generation

2.2.1.2 LZP-Generated Data Sets

• Ensure that the system in the “LZP” mode

• This mode will ingest a stream of CADUs from either the SIM card or the TRS, frame synchronize these
CADUs, perform RS detection and correction, and perform path (or packet) service on the extracted
VCDUs.

• From the UI select the Load or Edit option

• If Edit is selected, type in the name of the catalog to be loaded and edited

• The opened catalog will display the editable pages

• After re-editing the catalog, the option to Save and/or Activate is used to run the catalog

• If Load is selected, type in the name of the file to be loaded

• Once the file is loaded the option to Enable is used to run the catalog

• The various status pages will monitor the processing status
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• Once the whole data scenario, i.e. the specified number of CADUs have been processed, the AP will
create a directory listing of the available data generation instructions on the AP disk, and the SV together
with the RE would have stored sorted packets on the Ciprico

• In the commands list, select the Data Set Distribution command

• From the displayed page select the Browse option for the session under review

• From the listing of the files, select the specific file for transfer and enter the destination for the file

• From the displayed file select the Ship It! option to send the file out to the CDS
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Sorted Packets
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Packets

Sorted 
Packets

Annotation 
Processor

EOS  
Sync EOS 

Sol 
Dec EOS Service 

Processor
512 MB 
Memory 

Card

TRS 
Subsystem

EDS, PDS 

Annotation

Annotation

VCDU Stream Packet 
Stream

Test 
Data

FDDI 
Interface 
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CDS 
Workstation

Figure 2-7. LZP-Generated Data Sets

• Once a file is on the CDS, use the RECORD mode on the TRS via the GUI to store it on the SONY
(TRS)

• Once all the files are transferred, the data on the Ciprico can be over-written

• When needed, the data sets are transferred from the TRS to the HRS Ciprico via the CDS.
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Figure 2-8. Offline storage & Restaging of LZP Generated Data Sets
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Using the ETS HRS

3
The ETS HRS control environment provides tools for controlling and
monitoring operation of the Very Large Scale Integration (VLSI) High-rate
System, and managing the distribution of telemetry data to user sites.

3.1  Log in to the ETS HRS
To use the ETS HRS system, the user must first log into the Control Workstation. Contact a System Administrator
for account setup, user name, and password. To log in, enter the assigned user name and password. Upon
successfully loging in, an HP menu bar appears at the bottom of the monitor screen.  Perform the following::

1. Open a terminal window by clicking on Terminal Icon on the HP menu bar or selecting X-Term from
Utilities  folder in the General Toolbox at the right hand corner of HP menu bar.

2 Change directory to login account where TPCE is located by entering  cd /users/tpcedemo at the
terminal prompt to change to the operating directory.

3. Enter the ETS hrs command in the open terminal window.  The following HRS Main window should
appear.

The Monitor window is the main TPCE window for ETS HRS. This window provides an indication of the overall
status of the system’s primary components. Users can view/modify the most recent event log file, access the
controlling functions of the ETS HRS, and access status displays. To open main TPCE window, click on the raised
button labeled “HRS TPCE”.
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IMPORTANT !         Special Instructions on boot up.

Mode of operation.

The HRS system may operate in 1 of 2 modes, The Level Zero Processing (LZP) mode and Big Disk Mode.

View the Master Controller Status page 'Card Status', See Section 6.1 and 6.2 Status and Reports, to verify what
mode the HRS system is currently in.

LZP MODE BIG DISK (Operational) MODE

Card Status Card Status
SX1 SX1
FS1 AP1
RS1 FD1
SV1
RE1
LZP1

If necessary, Use the Reboot command, see section 5.12, to toggle between the 2 modes.
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3.2 Control and Monitor
The Menu list in the Monitor window is used to initiate ETS HRS command and monitoring functions. The File
menu contains items for event log operations and exiting the ETS HRS. The Edit menu contains items for
changing/viewing the activity schedule, annotating the event log, and modifying configuration and preferences,
and selecting the desired message filter. The View menu contains items for viewing old event logs and displaying
the list of data sets being distributed. The ETS HRS menu pops up upon clicking on the ETS HRS icon on the
Monitor window.  The ETS HRS menu contains selections for performing manual system commanding, and
viewing overall session, processing, and subsystem status.

3.3 System Component Status Display
VLSI-HRS general status is indicated by the color (or lack of color) surrounding the components icon in the
Monitor window. A color represents the collective status of the Simulator, Frame Synchronizer (FS), Reed-
Solomon (RS), and Service Processor Cards of the VLSI-HRS.  Status colors are:

• None: all VLSI-HRS cards are functioning properly.

• Yellow: a VLSI-HRS card is booting.

• Red: a VLSI-HRS card is not functioning properly. Communication with the VLSI-HRS is not possible.

NOTE:

Commanding VLSI-HRS is not possible when the status color is yellow or red.

3.4 Event Log Display
The event log contains messages pertaining to ETS HRS operation. These messages are generated automatically
from the ETS HRS software. The messages can also be generated manually by operators of the ETS HRS (refer to
Section “Working with the Event Log”). The information displayed in the Monitor window’s scrolling list is the
current event log information.

When the event log reaches a predetermined maximum file size, the log is closed and a new event log is created.
The naming convention of event log files is based on the start and end times for opening and closing the event log.
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3.5 Exit the ETS HRS
Except in unusual circumstances, there is no need to exit the ETS HRS system. If it is necessary to exit, first close
all open ETS HRS windows in order to prevent accidental loss of data.

1 Select Exit  from the File menu in the Monitor window.

A confirmation window is displayed.

2 Click the Button to shut down the ETS HRS.

The ETS HRS application quits.

NOTE:

HRS is required to complete a warm boot no longer that 10 minutes.  When you exit from
TPCE, system is gracefully shutting down all opening processes and network sockets.  It is
necessary that you wait for at least 60 seconds before bring up TPCE again after a graceful
shutdown.
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Configuration Set
Editor

4
The section provides basic instructions on how to
examine and/or modify the parameter values in an
existing configuration set, or to define a new
configuration set.

4.1 Display Configuration Set Editor
A configuration set is a data file that contains telemetry processing setup parameters used to initialize the VLSI-
HRS for a session. A configuration set consists of one or more setup blocks, each corresponding to a VLSI-HRS
subsystem. Each setup block contains a group of parameters and associated values.  To display the Configuration
Set Editor window, select Configuration Sets... from the Edit menu in the Monitor window.

4.2 Create a New Configuration

To create a new set of telemetry processing parameters using the Configuration Set Editor, select New... from the
File menu. If an open configuration set with unsaved changes exists, the user will be prompted to save those
changes (refer to Section 5.11, Save Changes to a Configuration Set).

An untitled configuration set is created, which contains all available subsystems. These subsystems appear in the
Subsystems list.

Select the card to be configured from the Subsystems list (e.g., Frame Sync.).  The associated parameters for the
selected (highlighted) card will appear on the Configuration Set Editor for editing.

4.3 Retrieve Remote Configuration Set
The Retrieve Remote Configuration Set command allows user to get catalogs previously defined and stored on the
VME local disc.   Before a remote configuration set may be retrieved, an Update Remote Configuration Set
Directory  must be issued.  See Section 5, manual Control of Processing.

1 Click on the VLSI-HRS subsystem icon in the Monitor  window.

The Quick Status window is displayed.

2 Click on the Command... button within the Quick Status display.

The list of commands for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over Retrieve Remote Configuation Set..., and
release the mouse button to display the following window.
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4.4 Edit Existing Configuration S
To modify the telemetry processing parameters in an existing Configuration Set, perform the following:

1 Select Open... from the File menu in the Configuration Set Editor window. If an open configuration set
with unsaved changes exists, the user will be prompted to save the changes (refer to Section 5.11, Save
Changes to a Configuration Set).

A listing of the available configuration sets is displayed.

2 Select the configuration set to be opened.

3 Highlight the subsystem (e.g., FS Subsystem) to show the associated parameters for configuring the card.

4. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter.

4.5 View Subsystem Parameter
Each subsystem in the configuration set contains a list of parameters with associated values for the parameters. To
examine a subsystem’s parameters and associated values, perform the following:

1 Select the desired subsystem from the Subsystems list (e.g., Command Block Processor).

The list of parameters appears in the Subsystem Parameters list.

2 Select a parameter and view its description.

The parameter’s description appears in the Description field.
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4.6 Add Subsystems to Configuration
To add VLSI subsystems to a configuration set, perform the following:

1 Select Add/Remove Subsystems... from the Edit menu of the Configuration Set Editor window.

2 Select the desired subsystem from the Available Subsystems list. The selected subsystem highlights.

3 Click the Add button to add the selected subsystem to the list of subsystems in the configuration set. The
selected subsystem is removed from the list of available subsystems and appears in the list of current
subsystems.

4 Repeat steps 2 and 3 until all desired subsystems are added to the configuration set.

5 Click the Save button to add subsystems to the configuration set. The Subsystems list in the
Configuration Set Editor window updates to reflect the revised subsystem list.

4.7 Remove Subsystems from Configuration
To remove VLSI subsystems from a configuration set, perform the following:

1 Select Add/Remove Subsystems... from the Edit menu in the Configuration Set Editor window.

2 Select the subsystem to be removed from the Subsystems in Configuration Set list. The selected
subsystem highlights.

3 Click the Remove button to remove the subsystem from the list of subsystems in the configuration set.
The selected subsystem is removed from the list of current subsystems and appears in the list of available
subsystems.

4 Repeat steps 2 and 3 until all desired subsystems are removed from the configuration set.

5 Click the Save button to replace the previous list of configuration set subsystems with the new list
containing fewer subsystems. The Subsystems list in the Configuration Set Editor window updates to
reflect the revised subsystem list.

4.8 Save Changes to a Configuration Set
Modifications to a configuration set do not take effect until changes are saved. Once changes are saved, they can
only be undone by re-editing the schedule.

1 Select Save from the File menu in the Configuration Set Editor window. If the configuration set has not
been given a name, a dialog box appears prompting the user for a new configuration set name.

2 Enter the name of the configuration set.

3 Click the OK  button to save the configuration set.

4.9 Save Changes to a Different Configuration
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If an existing configuration set was modified, the user can save changes as a new configuration set, rather than
writing over the original.

1 Select Save As... from the File menu in the Configuration Set Editor window.

2 Enter the name of the configuration set.

3 Click the OK  button to save the new configuration set with the given name.

4.10 Edit Simulator Card Configuration
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the Simulator Card subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follows:

Output Data Mode = FT  Forward True data
Run mode = 2,  specify the total number of data units (frames or blocks) output from the card

each time it is activated, or set up the card to continuously output data (after
activation) until it is shut down. To specify a fixed number of data units output
from the card, enter 2. Then, enter the number of frames using 'Run Mode Catalog
Entry ' (see below). To select continuous data output, enter 3.

Run Mode Catalog Entry = 4096  Numbers of frames to be output of Sim Card, use with Run Mode 2.
NCO Frequency = specify the output frequency of the SIM Card.
File Records = {Block}
Frame Size =   1024 (Frame size of data set)
Number of Frames =  0     Specify number of frames to be loaded into the card for the test, 0 loads all.
Filename =   /ets/data/'filename' enter the base filename of the dataset.  For the HRS, SCTGEN produces a base

file (filename.b) and an updated file (filename.u).

Slip = No   Yes turn the slip function on, or No, turn the slip functiion off .  If Yes, select
options for S1 and S2 below.

S1 Position = 25         The first frame to be slipped.
S2 Position = 1024      The second frame to be slipped.
S1 Gain = LOSS         The first slip may be LOSS or  frame to be slipped short.GAIN,  frame to be

slipped long.
S2 Gain = LOSS The first slip may be LOSS or  frame to be slipped short. GAIN,  frame to be

slipped long.

External Clock = NCO Control
Update = No   Updates will be made to the Sim Card Memory by software.
Update by SCSI = No  (not yet implemented with HRS)
CRC = No
RS =  No
BTD = No
Interleave = 4

Slip 1: Number of Bits = 0     The number of bits to slip (0-3) for slip number 1.
Slip 2: Number of Bits = 0 The number of bits to slip (0-3) for slip number 2.

Slip 1: Number of Bytes within frame = 0     Which byte in the frame (0-1024), for slip 1.
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Slip 2: Number of Bytes within frame = 0     Which byte in the frame (0-1024), for slip 2.
Clock Mode = Continuous, Define clock type (e.g., Continuous [0], Invert Continuous [1],

Gated [2], or Off [3]).  For most cases select continuous.
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4.11 Edit Frame Synchronizer Card Configuration
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the Frame Synchronizer subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follow.

Forward Correlator = {Block}

Sycn Pattern 1 = 1A Forward True Sync Pattern Byte 1

Sycn Pattern 2 = CF Forward True Sync Pattern Byte 2

Sync Pattern 3 = FC Forward True Sync Pattern Byte 3

Sync Pattern 4 = 1D Forward True Sync Pattern Byte 4

Sync Pattern Mask = FF

True Search Tolerance = 0

Inverse Search Tolerance = 0

Sync Size = 4  (Number of bytes in sync pattern)

Reverse Correlator {Block}

Sycn Pattern 1 = B8  Reverse True Sync Pattern Byte 1

Sycn Pattern 2 = 3F  Reverse True Sync Pattern Byte 2

Sync Pattern 3 = F3 Reverse True Sync Pattern Byte 3

Sync Pattern 4 = 58 Reverse True Sync Pattern Byte 4

Sync Pattern Mask = FF

True Search Tolerance = 0

Inverse Search Tolerance = 0

Sync Size = defines size in bytes of the sync pattern expected. For ETS, use 4.

TFS Chip {Block}

Accept Forward Sync = Yes or No  (Default is Yes)

Accept Reverse Sync = No or Yes  (Default is No)

Accept True Sync = Yes or No  (Default is Yes)

Accept Inverted Sync = No or Yes (Default is No)

Fix Inverted Data = No or Yes  (Default is No)

Fix Inverted Sync = No or Yes (Default is No)

Fix Reversed Data = No or Yes (Default is No)

Use Bestmatch = Yes (instructs card to use best-match in synchronizing to the sync pattern.)

Output Size = 16 bit or 8 bit  (Default is 16)
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Initial CRC state = 0 or 1 (Default is 0)

Enable CRC = No or Yes  (Default is No)

Frame Size = 1034 (in bytes)

CRC Polynomial = 0

RAM I/O Control Register = 2146  (Use this default value)

Output Data = Lock (Output data on never, always, check, lock)

Search/Check Slip = defines slip window strategy for synchronization in search and check
modes; can be set from 0 to 3.

Lock/Flywheel Slip = defines slip window strategy for synchronization in lock and flywheel
modes; can be set for bit slips from 0 to 3.

Flywheel Tolerance = defines tolerance strategy in flywheel mode; can be set for flywheel
frames from 0 to 16. (need selection for the range?)

Check Tolerance = defines tolerance strategy in check mode; can be set for check frames from
0 to 16. (need selection for the range?)

ECL Mux = For ETS, use mode 3. (values are: 0= Output TTL Mux, 1= J2 data & operational clock, 2 =
J2 Test data & clock, 3 = Front Panel SMA's)

TTL Mux = For ETS, set to 0 (0 = turns of TTL mux)

QL FIFO Mux = GTFS or Timecode

QL FIFO Mode = Word  (Write mode: byte or word)

Trailer Type =  For ETS, set to 3  (values are:  0 = none, 1 = 2-byte quality (attach a 2-byte quality
annotation to the end of the frame), 2 = 6-byte timecode (attach a 6-byte timecode annotation to the end
of the frame), and 3 = 10-byte quality + timecode (attach a 2-byte quality annotation followed by an 8-
byte timecode annotation to the end of the frame).

PN Decode = instructs card as to whether Pseudonoise (PN) decoding has to be performed, and if so,
how.  For ETS, set to 0  (0 = none (no decoding), 1= decode, include sync (perform decoding including
the sync as a part of the frame), 2 = decode, exclude sync (perform decoding excluding the sync as a part
of the frame).

4.12 Edit Reed-Solomon Card Configuration
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the Reed-Solomon subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follow.

Frame Length = because the source of frames is the EOS Frame Synchronizer Card, the frame
length is entered as the actual (i.e., without the frame synchronization pattern) frame (VCDU) length
plus the annotation added by that subsystem. In this case, it is 2 bytes of frame quality and an 8-byte
time-stamp.  For ETS VHS, use 1034.

Interleave Level = 4

Codeword Length = ranges from 33-255 bytes. For ETS VHS setup, set codeword length to 255.

Frame Sync Length = For ETS VHS, use 4
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Append Trailer = Yes (generates a 32-byte quality annotation block)

Reject Uncorrectables = Default is Yes

Reject Unroutables = Default is Yes

Block Detection = Default is Yes

Block Correction = Default is Yes

Header Detection = Default is No

Header Correction = Default is No

Input Mode = Default is words

Output Mode = Default is words

Routing Table {Block}  Enables up to 63 frames to be rounded based on parameters below:

RS Routing VC # 0 {Block}
   RS Node 0

Valid  = Valid Frame valid, route to port 0-5, frame.  Frame invalid, do not route.
Version = 2   The HRS uses CCSDS version 2 frames
SCID = 42    The spacecraft ID for HRS is 42.
VCID  = 63      The vertual channel ID for this table entry,  0-63.
Port = 5 Route frame to ports 0-5 of RS card,  system is configured for port 5.
Trash = No      Trash this frame.
Filter  = No Filter this frame.

RS Routing VC # 2 {Block}
     thru

RS Routing VC # 63 {Block}

Entries = 0   Number of rounding tables entries

Filler = 0

4.13 Edit Service Processor Card Configuration
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the Service Processor subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follow.

Frame Length = for ETS HRS, raw frame length is 1024 bytes.

Frame Header =

FS Trailer = 10, indicates number of bytes to include in the annotation field that the FS will pass to the
EOS Service Processor regarding frame synchronization status. The selected size should be 2 or 10 bytes
(if timecode is appended).

RS Trailer = 32, indicate number of bytes to include in the annotation field that the FS will pass to the
EOS Service Processor regarding Reed-Solomon decoding status. The selected size should be 32 bytes.

RS Interleave = 4, for ETS, select an interleave depth of 4 for a frame size of 1024 bytes.

Fill = selected value should be $C9.
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Zone Length = For ETS, use 0.

Del Long/Short = for ETS, specify Reject

Del Bad Packet = for ETS, specify Yes

Del Invalid VC = for ETS, specify Delete

Del TF Error = specify Delete

RS Encoded = for ETS, specify Yes

RS Decoded = for ETS, specify Yes

Frame Error Control Word = for ETS, specify No.

Reject as Session Start = for ETS, specify Yes

Reject Wrong Spacecraft ID  = for ETS, specify Yes

Reject Wrong Transfer Version = for ETS, specify Yes

Reject Wrong Packet Version = for ETS, specify Yes

Operational Control Field = for ETS, specify No.

2nd Header = specify if secondary header is present or not.

2nd Header Size = if secondary header is present and has to be verified, specify a length of 9 bytes.

RS Header Encode = for ETS, specify No.

Passthrough = for path service specify No. For trash buffer VCDU service, specify Yes, meaning that
the packet assembly is disabled.

Do Flywheel = for ETS, specify Yes

Transfer Frame Version = for ETS, specify 2

Packet Frame Version = for ETS, specify 1

4.14 LZP Subsystem
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the LZP Subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follow.

Segment Directory = HRSOPR - (a file created in OPMAN) file is loaded, which contains a list of
sources for each individual (VCID and APID) and indexed by number 1-150.  Used with 'Source
Entry' 1-150 below.

Ground Station = user-defined to identify data set.

Orbit ID = user-defined to identify data set.

Session ID = user-defined to identify data set.

Year = user-defined to identify data set.

Day = user-defined to identify data set.

Yearl = yyyy  (Year of start of mission)
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Dayl = ddd  (Day of year of start of mission)

Spacecraft ID = user-defined to identify data set.

Load Orbit ID =  Ignore  (1 = Load Orbit ID)

Load Session ID = Ignore  (1= Load Session ID, 0 = ignore

Load Ground Station = Ignore

Number Sources = 122    number of sources/indexes listed in the file 'HRSOPR' loaded above.

Source List = {Block}

Source Entry 1 = {Block}

Index =1

Service = Path

Playback = Disable

RT Packet = Disable

Quicklook = Disable

Turn On  = Active

Source Entry 2 = {Block}

   thru

Source Entry 150 = {Block}

4.15 LZP Limits Subsystem
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the LZP Limits Subsystem to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follows:

LZP Limits Subsystem

Hold Session = Off (1 = hold session option selected, 0 = off)

Block CRC Limit =  0 (Limit ratio of Nascom blocks with CRC errors to Nascom blocks received)

Block Min = 0 (Minimum number of Nascom blocks received)

Frame CRC Limit = 0 (limit ratio of frames with CRC errors to frames received)

Frame Min = 0  (Minimum number of frames received)

Reject TF Limit = 0  (Limit ratio of rejected transfer frames to frames received)

TF Min = N  (Minimum number of transfer frames)

Bad Packet Limit = N  (Limit ratio of bad and deleted packets to total packets

Packet Min = N   (Mimimum number of packets)
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4.16 High Rate Telemetry Backplane Configuration
To enter new or edit existing telemetry processing parameters in a Configuration Set, perform the following:

1 Select the Configuration Set Editor window.

2 Highlight the Telemetry Backplane Configuration to show the associated parameters for configuration.

3. Double click on a parameter, a subwindow is displayed.  Enter appropriate value(s) associated with that
parameter, as follows:

Config Filename  =  /ets/sub_systems/ETS tbp/bin/blue.cfg

Note: This above path specifies the default HRTB configuration file. The file itself is configured
using the tool tbptool, residing on the EOS Reed Solomon Card under OPMAN. In the operational
environment, this configuration file will not be changed. The default configuration file will be
preloaded in the system.
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Manual Control of
Processing

5
The Manual command menu is used to manually command the
VLSI. The window displays the status of the last VLSI
command executed, the time-tag for that command, and the
resulting processing or execution status.

5.1 Load a Configuration Set

To load telemetry processing parameters stored in a configuration set in the library, use the Load Configuration
Set... command. This command loads the configuration set, but does not enable VLSI subsystems (refer to Section
9.6, Enable VLSI Subsystems). All status counters are reset to zero when a new configuration set is loaded.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.
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Status 

Manual Commands 

Utility

Load Configuration Set 

Load Remote Configuration Set 

Activate Configuration Set 

Activate Remote Configuration Set 

Retrieve Remote Configuration Set 

Update Remote Config Set Directory 

 

Disable 

Enable 

Flush 

Shutdown 

Zero 

 

File Transfer 

Reboot 

Data Set Transfer

3 Hold the mouse button down, move the mouse cursor over Load Configuration Set..., and release the
mouse.

The Load Configuration Set window is displayed.

4 Select the configuration set to be loaded.

5 Click OK  to load the selected configuration set. The configuration set is loaded; the Load Configuration
Set command, time tag, and processing status appear in the Quick Status window.
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5.2 Load a Remote Configuration

To load telemetry processing parameters stored in a configuration set residing on the VLSI, use the Load Remote
Configuration Set... command. This command loads the configuration set, but does not enable VLSI subsystems
(refer to Section 9.6, Enable VLSI Subsystems). All status counters are reset to zero when a new configuration set
is loaded.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Load Remote Configuration Set..., and
release the mouse.

The Load Remote Configuration Set window is displayed.

4 Select the remote configuration set to be loaded.

5 Click OK  to load the selected configuration set. The configuration set is loaded; the Load Remote
Configuration Set command, time-tag, and processing status appear in the Quick Status window.

5.3 Activate a Configuration Set
To load telemetry processing parameters stored in a configuration set in the library and enable all VLSI
subsystems, use the Activate Configuration Set... command. All status counters are reset to zero when a new
configuration set is activated.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands displayed.

3 Hold the mouse button down, move the mouse cursor over Activate Configuration Set..., and release the
mouse.

The Activate Configuration Set window is displayed.

4 Select the configuration set to be activated.

5 Click OK  to activate the selected configuration set. The configuration set is loaded and the VLSI
subsystems are enabled. The Activate Configuration Set command, time tag, and processing status appear
in the Quick Status window.
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5.4 Update Remote Configuration Set

Once the user has just logged in, and TPCE is initialized, an Update Remote Configuration Set Directory is
required to to update telemetry processing configuration set residing on the VLSI-HRS.   Once complete, the user
may continue to use the "Activate Remote Configuration Set" or "Retrieve Remote Configuration Set".

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Update Remote Configuration Set
Directory , and release the mouse.

4 Upon completion of retrieval, a list of new catalogs will be displayed on Retrieve Remote
Configuration Set window.

5.5 Activate Remote Configuration Set
To load telemetry processing parameters stored in a configuration set residing on the VLSI and enable all VLSI
subsystems, use the Activate Remote Configuration Set... command. All status counters are reset to zero when a
new configuration set is activated.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Activate Remote Configuration Set..., and
release the mouse.

The Activate Remote Configuration Set window is displayed.

4 Select the remote configuration set to be activated.

5 Click OK  to activate the selected configuration set. The configuration set is loaded and the VLSI
subsystems are enabled. The Activate Remote Configuration Set command, time-tag, and processing
status appear in the Quick Status window.
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5.6 Retrieve Remote Configuration Set
To retrieve telemetry processing parameters stored in a configuration set residing on the VLSI and enable all
VLSI subsystems, use the Retrieve Remote Configuration Set... command.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor  window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Retrieve Remote Configuration Set..., and
release the mouse.

The Retrieve Remote Configuration Set window is displayed.

4 Upon completion of retrieval, a list of new catalogs will be displayed on Retrieve Remote
Configuration Set window.

5.7 Disable VLSI Subsystems

To disable one or more VLSI subsystems, use the Disable... command. No data is processed when subsystems are
disabled.

1 Click on the desired VLSI-HRS subsystem icon in the Monito r window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Disable..., and release the mouse.

The Disable window is displayed.

4 Select the subsystems to be disabled.

5 Click OK  to disable the selected subsystems. The Disable command, time-tag, and processing status
appear in the Quick Status window.

5.8 Enable VLSI

To enable one or more VLSI subsystems, use the Enable... command so that data processing can occur.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor  window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.
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The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Enable..., and release the mouse.

The Enable window is displayed.

4 Select the subsystems to be enabled.

5 Click OK  to enable the selected subsystems. The Enable command, time-tag, and processing status
appear in the Quick Status window.

5.9 Flush VLSI Subsystems

To flush one or more VLSI subsystems, use the Flush... command. This command flushes all data currently in
process by a subsystem to the next subsystem within the pipeline.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor  window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Flush..., and release the mouse.

The Flush window is displayed.

4 Select the subsystems to be flushed.

5 Click OK  to flush the selected subsystems. The Flush command, time-tag, and processing status appear
in the Quick Status window.

5.10 Shut Down VLSI Subsystems

To shut down one or more VLSI subsystems, use the Shutdown... command. No data processing is performed
when subsystems are shut down. This is equivalent to a Flush command followed by a Disable command.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Shutdown... and release the mouse.

The Shutdown window is displayed.

4 Select the subsystems to be shut down.
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5 Click OK  to shut down the selected subsystems. The Shutdown command, time-tag, and processing
status appear in the Quick Status window.
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5.11 Zero Status

To zero the status counters for one or more VLSI subsystems, use the Zero Status... command.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Manual Commands... button within the Quick Status display.

The list of manual commands is displayed.

3 Hold the mouse button down, move the mouse cursor over Zero Status..., and release the mouse.

The Zero window is displayed.

4 Select the subsystems to be zeroed.

5 Click OK  to zero the status for the selected subsystems. The Zero Status command, time-tag, and
processing status appear in the Quick Status window.

5.12 File Transfer
Normally used in Big Disk (operational) mode.   See Reboot Command to switch between modes.

To initiate a file transfer session for the HRS, use the File Transfer... command.

If files exist on the Ciprico Hard Drive, upon entry, files will automatically display in the window.  Only
Construction records will be displayed at first.  Click on the Filename to be transferred.
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Enter Parameters below:
Target Directory: Enter where file is to be sent.    example: /users/tpcedemo/test
Target Host: The FDDI port name.    example: etsgsf2
User Name:  User name for the directory you are sending the file to.

example: combotst
User Password:  Enter password for the User name entered above.

Command buttons:
Send:  Used to send selected file from Ciprico directory to DAAC.
Delete: Used to delete selected file from Ciprico Directory.
Update: Update directory
Cancel:  Cancel file transfer
Done:   Used after all selected files have been transferred.  Sends signal of completion to

OMDSIM. Using the Update button again will display construction records.

Close: Closes the file transfer function

5.13 ReBootReboot, will reboot the HRS System to toggle between LZP and Big Disk (operational)
Mode.   It takes approximately 10 minutes for the system to boot.  By default, after power on, the system will be
in Big Disk (operational) Mode.

The HRS system may operate in 1 of 2 modes, The LZP mode and Big Disk Mode.  The Reboot command allows
the operator to toggle between the 2 modes.  For now, viewing the 'Master Controller Status'  page is the only
way to verify the current mode of the  HRS System.

LZP MODE BIG DISK (Operational) MODE

Card Status Card Status

SX1 SX1

FS1 AP1

RS1 FD1

SV1

RE1

LZP1
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5.14 Data Set TransferNormally used in LZP mode.   See Reboot Command to switch
between modes.

To initiate a file transfer session for the HRS, use the Data Set Transfer... command.
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Status and Reports

6
Status windows allow the user to monitor the ETS
HRS system. Status information is updated every 4
seconds so that the ETS HRS may be monitored in
near-real time.

6.1 System Quick Status
Quick Status offers fast access to overall status information on the cards and the current session for a VLSI-HRS.
Quick Status is accessed directly from the Monito r window using color coded icon or Event Log messages.

1 View color code of the VLSI-HRS subsystem icon in the Monitor  window.  The color of the VLSI-HRS
icon reflects the status corresponding to the status of the cards:

None: card is functioning correctly.

Yellow: card is booting.

Red: card is not functioning correctly and should be examined.

2 View Event Log in the Monitor window (e.g., failed to connect to VLSI 1).

3 Click on the VLSI-HRS subsystem icon in the Monitor  window, a system quick status window appears.
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6.2 Master Controller Card
The Master Controller Card status window provides high-level status, including the current state of operation,
currently loaded configuration set, and communication traffic numbers.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.
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Status 

Manual Commands 

Utility

Master Controller Status 

Service Processor General Status 

Service Processor VC Status 

Service Processor Source Status 

Service Processor Trigger 

Reed-Solomon Status 

Frame Sync Status 

Simulator Status 

LZP Status 

Annotation Status 

File Transfer Status 

Frame Sync Time Status 

3 Hold the mouse button down, move the mouse cursor over Master Controller..., and release the mouse
button.

The Master Controller Status window is displayed.
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Fields are defined as follows:

General Information

Commands Received:   specify number of commands received from the workstation.

Responses Sent:  specify number of responses sent to the workstation.

VLSI System Number:  For ETS HRS, only one VLSI system (designated as 0)
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Number of Slave Cards: specify default configuration

Number of Subsystem:  specify number of custom cards and subsystem tasks

Card Information :  List of custom cards which either in Ready or Disable state.

Subsystem Information:  List of subsystems which are either disabled or enabled.

Mnumonic Subsystem Identifier

SX 996A8000

FS BF361800

RS A90A800

SV 89400000

RE A5140000

Port Information: Number of ports and type of data associated with that port (e.g., status).

Port Number Descriptions

3000 Commands & Responses

3100 Status

3200 Event Messages

6.3 Simulator Card Status
The Simulator Card status window provides detailed information on simulating data.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over Simulator Status..., and release the mouse
button.

The Simulator Status Editor window is displayed.
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Fields are defined as follows:

Health: status of hardware during operation; may read Ok, Good, Bad, Dead, or Booting.

STATUS INFORMATION :

Data File: name and path of data set file (e.g.,  /ets/data/HRSclean.cadu).

Run Mode: indicate whether card is generating data or stopping (e.g., transfer X patterns)

Output Mode: indicate whether data is generated in forward, reverse, true, etc.
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Frame Size: number of bytes in a frame.

Frame Loaded: number of frames to be loaded per run.

Frame to Output: indicate number of frames output.

Frame Count: number of frames have been generated.

Memory Size (MB): number of available bytes in memory.

RS Interleave: indicate Reed-Solomon interleave level.

Slip Function: indicate FALSE if no slip function is selected; TRUE if either one of two slip
functions is selected.

Slip Frame 1: indicate GN if gain is detected; LS if loss bit is detected in Slip No. 1 function.

Byte position 1: indicates into which byte in the frame the slip bit is to be injected.in Slip No. 1
function.

Slip Bit 1: indicate 0, 1, 2, or 3 depending on number of bit slip(s) detected.

Slip Gain 1: indicate 0, 1, 2, or 3 depending on number of bit slip(s) detected.

RS-422 to Card: indicates output to RS-422 port.

NCO Frequency: indicate clock output frequency (e.g., 50 MHz).

Clock Mode:  Continuous

ESCOM Seconds Counter: indicates error occurred.

CRC Encode: indicate if CRC encoding scheme is used.

RS Encode: indicate if Reed-Solomon encoding scheme is used.

BTD Encode: indicate if bit transition density is selected.

STGEN Update: indicate whether the update function is exercised.

Board Revision: indicate hardware revision number of board.

Slip Frame 2: indicate GN if gain is detected; LS if loss bit is detected in Slip No. 2 function.

Byte position 2: indicates into which byte in the frame the slip bit is to be injected.in Slip No. 2
function.

Slip Bit 2: indicate 0, 1, 2, or 3 depending on number of bit slip(s) detected.

Slip Gain 2: indicate 0, 1, 2, or 3 depending on number of bit slip(s) detected.

Update Method:  Use software update function.

6.4 FS Subsystem Status
1 Click on the VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button in the Quick Status display.

3 Hold the mouse button down, move the mouse cursor over Frame Sync Status, and release the mouse
button to view overall status of FS Card.
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4 Scroll up and down to display the Frame Synchronizer Status.

Fields are defined as follows:

Health: status of hardware during operation; may read Ok, Good, Bad, Dead, or Booting.

Synchronization Status Information:

Frame Mode:   Back-to-Search

Frame Count Information:

Search Frames: maintains a count of frames processed in search mode. The number of frames
processed in search mode is completely dependent on the setup of the card’s search, check,
and lock logic and the corresponding bit error tolerances. However, for the typical setup, if
no errors occur in the input data, only one search frame is reported.

Check Frames: maintains a count of frames processed in check mode. The number of frames
processed in check mode is completely dependent on the setup of the card’s search, check,
and lock logic and the corresponding bit error tolerances. However, for the typical setup,
and if no errors occur in the data, this value is between 0 and 15.
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Lock Frames: maintains a count of frames processed in lock mode. The number of frames processed
in lock mode is completely dependent on the setup of the card’s search, check, and lock
logic and the corresponding bit error tolerances. However, if no errors occur in the input
data, once the logic has moved into lock mode, it stays in lock mode. Therefore, for error-
free data, once this value starts to increment, it should continue to increment without the
Search Frames or Check Frames values incrementing.

Flywheels: total number of flywheel frames detected. Flywheel frames are frames detected in lock
mode with more bit errors than the set tolerance permits.

Back to Search: value is the number of times card switched from lock to search mode.

Reverse Inverted: value is the number of reverse inverted frame sync patterns detected by the card.

Reverse True: value is the number of reverse true frame sync patterns detected by the card.

Forward Inverted:  value is the number of forward inverted frame sync patterns detected by the
card.

Forward True:  value is the number of forward true frame sync patterns detected by the card.

Error Count Information:

CRC Errors : field is valid with forward data; displays number of detected frames with CRC errors.
The field is applicable only if the card is set up to check CRC. If the card checks CRC
values, it calculates a frame CRC based on the data input and compares it to the expected
CRC value that is supplied in the frame trailer; if the two values do not match, a CRC error
is recorded.

Sync Errors: displays number of detected frames with synchronization pattern errors. If card is not
set up with a frame synchronization pattern bit error tolerance, frames with a
synchronization pattern error will not be detected. If a synchronization pattern bit error
tolerance is set, the card can only detect frames with synchronization pattern bit errors less
than or equal to the set tolerance.

Slip Errors : value is the number of frames processed with a long or short bit slip (frame was longer
or shorter than expected length). If the EOS Frame Synchronizer Card is not set up with a
slip tolerance, frames that are too long or too short are not detected. If a slip tolerance is set,
the card can only detect bit slips (long or short) that are less than or equal to the set
tolerance.

Long Slip Errors : number of frames processed with a long or short bit slip (frame was longer or
shorter than expected length). If the FS Card is not set up with a slip tolerance, frames that
are too long or too short are not detected. If a slip tolerance is set, the card can only detect
bit slips (long or short) that are less than or equal to the set tolerance.

Frame Sync Test Count Information

Test Mezzanine Output Units: displays whether detected frames are in true, reverse, inverse.

6.5 Frame Sync Time Status
1 Click on the VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button in the Quick Status display.

3 Hold the mouse button down, move the mouse cursor over Frame Sync Time Status, and release the
mouse button to view overall status of FS Time.
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Time Normal Polarity (Acquired) : time in Julian days, hours, minutes, seconds, and milliseconds when lock
was acquired on the first frame received with normal polarity through the EOS Frame Synchronizer Card for a
particular session.

Time Normal Polarity (Lost): time in Julian days, hours, minutes, seconds, and milliseconds when lock was
last lost on the normal polarity frame stream through the EOS Frame Synchronizer Card for a particular
session. Lock can be regained; thus, this value is updated when lock is subsequently lost by a frame later on
in the frame stream.

Time Inverted Polarity (Acquired) : time in Julian days, hours, minutes, seconds, and milliseconds when
lock was acquired on the first frame received with inverted polarity through the EOS Frame Synchronizer
Card for a particular session.
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Time Inverted Polarity (Lost): time in Julian days, hours, minutes, seconds, and milliseconds when lock was
last lost on the inverted polarity frame stream through the EOS Frame Synchronizer Card for a particular
session. Lock can be regained; thus, this value is updated when lock is subsequently lost by a frame later on
in the frame stream.

Time Reverse Bit Order (Acquired): time in Julian days, hours, minutes, seconds, and milliseconds when
lock was acquired on the first frame received in reverse bit order through the EOS Frame Synchronizer Card
for a particular session.

Time Reverse Bit Order (Lost): time in Julian days, hours, minutes, seconds, and milliseconds when lock
was last lost on the frame stream received in reverse bit order through the EOS Frame Synchronizer Card for
a particular session. Lock can be regained; thus, this value is updated when lock is subsequently lost by a
frame later on in the frame stream.

6.6 RS Subsystem Status

Reed-Solomon Status
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Frame Information:

Input Frames: displays number of frames input to the card from the EOS Frame Synchronizer.

Long Frames: number of frames input to the Reed-Solomon Card that were longer than expected
length. Expected length is defined in card setup.

Short Frames: number of frames input to the Reed-Solomon Card that were shorter than expected
length. Expected length is defined in card setup.

Frames Filtered: count of frames based on selected SCID and VCID combination filtered from the
output stream and discarded.

Frame Corrected: count reports number of frames with detected errors (header or codeword) that
were corrected.

Unroutable Frames: count of frames that EOS Reed-Solomon Card received as input frames, but
could not output due to unrouteable errors.

Unccorrectable Frames: count of frames that Reed-Solomon circuitry detected errors that were
uncorrectable.

Frames Output to Port 0: displays number of frames distributed via the output port 0 on the Reed-
Solomon Card. For the ETS HRS, only one port will be selected to correspond to the input
port on the EOS Service Processor Card as set up by the HRTB.

Frames Output to Port 1: displays number of frames distributed via the output port 1 on the Reed-
Solomon Card.

Frames Output to Port 2: displays number of frames distributed via the output port 2 on the Reed-
Solomon Card.

Frames Output to Port 3: displays number of frames distributed via the output port 3 on the Reed-
Solomon Card.

Frames Output to Port 4: displays number of frames distributed via the output port 4 on the Reed-
Solomon Card.

Frames Output to Port 5: displays number of frames distributed via the output port 5 on the Reed-
Solomon Card.

Frames Output to Trash: count of frames routed to the trash buffer. Any frames can be routed to
this buffer based on SCID and VCID combination. All rejected frames are also routed to this
buffer. This buffer holds only seven full 1024-byte frames that are discarded.

Frames Output to Tape Drive: count of frames routed to the Tape Recording Subsystem for
storage.

Frames to Qty Reject Buffer: count of frames routed to the quality reject buffer based on the
uncorrectable and unrouteable status of the frames. This buffer holds only seven full 1024-
byte frames that are discarded.

Frames not Output Anywhere:

Error Statistics:

Corrected Codewords: count of codeword errors detected and corrected by the card. More than one
error can occur in the same codeword. (Note that frames with an interleave greater than one
have more than one codeword.)

Uncorrected Codewords: count of codewords with uncorrectable errors.

Block Errors : count of frame block errors, where block refers to the entire frame, as opposed to the
header only or data space only.
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Bit Errors : number of frame bit errors.

Corrected Headers: count of frame headers with errors detected and corrected by the card. More
than one error can occur in the same frame header; therefore, this field does not reflect the
number of header errors. For that value, refer to Header Errors field.

Uncorrected Headers: count of frame headers with uncorrectable errors.

Header Errors: number of frame header errors.

Configuration:

6.7 Service Processor Status
The Service Processor General status window provides detailed information on the packet assembly being
processed by the system.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over Service Processor General Status, and
release the mouse button to display the following window.
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Fields are defined as follows:

Health: status of hardware during operation; may read Ok, Good, Bad, Dead, or Booting.

Frame Information :

Input : count of frames recognized by the card.

Rejected: incorrect frames will also be displayed as ‘Bad SC ID’, ‘Bad Version’ ‘Bad VCID’, ‘RS
start errors’, ‘Bad 1st header pointer (FHP)’, ‘Long’, and ‘Short’,.  ‘Rejected’ will display a
total for the ‘Bad VCID’, ‘RS start errors’, ‘Bad 1st header pointer (FHP)’, ‘Long’, and
‘Short’ only.  Processing will continue displaying information  for packets.

Deleted: incorrect frames  will be displayed as ‘Bad SC ID’, ‘Bad Version’ ‘Bad VCID’, ‘RS start
errors’, ‘Bad 1st header pointer (FHP)’, ‘Long’, ‘Short’,  and ‘flywheel’ .  ‘Deleted’ will
display a total for the ‘Bad VCID’, ‘RS start errors’, ‘Bad 1st header pointer (FHP)’, ‘Long’,
‘Short’,  and ‘flywheel’ bad frames only. There will be no further processing done to
packets within deleted frames, and no status displayed for packets under  ‘Packet
Information’.

Idle: count of idle frames recognized by FEP(s), however most will be filtered by the Frame Sync
card, depending on set-up.
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Bad SCID: count of frames with bad spacecraft identifier.

Bad Version: count of frames with incorrect version number. For ETS, frames with Version 2 are
valid.

Bad VCID: count of frames whose VCID is not identified in the processing catalog.

Bad FHP: count of frames with bad first header pointer.

Long: count of frames with incorrect length (longer than expected).

Short: count of frames with incorrect length (shorter than expected).

VC Breaks: count of frames with sequence counts that are not contiguous.

Start Errors : count of frames with starting sequence counts not as expected.

Packet Information:

Output : count of valid packets recognized by the card.

Realtime: count of real-time packets recognized by the card.

Bad: count of packets recognized by the card as having invalid parameters.

Deleted: count of packets deleted from the output queue.

Idle: count of idle packets recognized by the card.

RS Corrected: count of packets extracted from R-S correctable frames .

Short: count of packets shorter than expected length. Expected length is defined in card setup.

CRC Errors : number of packets embedded in frames with CRC errors.

RS Errors: number of packets embedded in frames with Reed-Solomon errors.

Bad SPID: number of packets embedded in frames with bad spacecraft identifiers.

Bad Version: number of packets with incorrect version numbers.

Piece Information:

Rejected: packets with Bad App ID, Bad Length, No packet header, Bad Time.  If a packet is Bad,
status will be displayed under ‘Packet Information’, ‘Deleted’ and ‘Bad’. Packet  pieces or
cause of the packet error , will be displayed under ‘Piece Information’ for packets with ‘Bad
App ID’, ‘Bad Length’, ‘No Packet Header’, ‘Bad Time’.  The total deleted packets will be
displayed by ‘Rejected’.

Bad App ID: number of packets with an invalid application process identifier.

Bad Length: number of packets shorter or longer than expected length. Expected length is defined in
card setup.

No Header: number of packets unrecognizable by the card.

Bad Time: number of packets with invalid time fields.

Output Information :

Records: value maintains number of records being transferred via DMA.

The Service Processor Virtual Channel status window provides detailed information on the individual VC being
processed by the system.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.
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The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over Service Processor VC Status, and release the
mouse button to display the following window.

Virtual Channel : defines the column for each VCID

Input Frames: number of frames assigned with the associated VCID.

Rejected Frames: number of frames with the associated VCID that were rejected.

Deleted Frames: number of frames with the associated VCID that were deleted.

Idle Frames: number of idle frames.

CLCWs:

Discontinuities:

Missing Frames: number of frames missing with the associated VCID. Note that this value will not be an
accurate measure of the number missing if the sequence number rolls over (i.e., 65,536). Not used
for ETS HRS.

CRC Errors : number of frames with the associated VCID that were detected with CRC errors (not used for
ETS HRS).

RS Corr Frames: number of frames in which the card detected correctable errors.

RS Corr Symbols: number of codeword symbols that the EOS Reed-Solomon Card was able to correct.

RS Uncorr Frames: number of frames in which the EOS Reed-Solomon Card detected uncorrectable errors.
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Idle Packets: number of idle packets within the VCID stream (not used in ETS HRS).

Idle Bytes:

VCDU Services: number of VCDUs from specified VCID used for VCDU service (not used in ETS HRS).

VCA Services: number of virtual channel access units from specified VCID used for VCA service (not used
in ETS HRS).

The Service Processor Source status window provides detailed information on individual source being processed
by the system.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over Service Processor Source Status, and release
the mouse button to display the following window.

VC Range: identify VCID associated with each index

APID : value should match with number of items setup in the processing catalog.

Output : number of packets processed for each pair of VCID and APID.
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RS Corrected: count of frames based on selected SCID and VCID combination filtered from the
output stream and discarded.

RS/CRC Errors: number of packets from frames with CRC/Reed-Solomon errors.

Padded: number of packets that required padding.

Deleted: number of packets deleted during the session.

Sequence Errors: number of packets processed for each pair of VCID and APID that has sequence
error.

6.8 LZP Status
The ETS LZP status window provides detailed information on LZP function:

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over LZP Status..., and release the mouse button.
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The LZP Status window is displayed

Fields are defined as follows:

Health: status of hardware during operation; may read Ok, Good, Bad, Dead, or Booting.

General Information

Setup File:

Session ID: user-defined to identify data set.

Ground Station: user-defined to identify data set.

Active VCIDs:

Active Sources:

AP Status:

Time Since Acquisition:
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Orbit Number:

Day of Year:

MS of Day

Data Direction:

Data Count Information:

Nascom Blocks:  Not used for ETS HRS

Transfer Frames: number of CCSDS frames input to the EOS Frame Synchronizer Card.

Packets: number packets processed by the EOS Service Processor Card.

Real-time Packets: number of real-time packets processed by the EOS Service Processor Card.

Session Data Sets: number of data sets processed by the AP Card during the session.

Total Data Sets: number data sets processed by the AP Card during one or more sessions.

Gaps Detected:

CRC Errors Detected: number of CCSDS frames detected with CRC errors by the EOS Frame
Synchronizer Card.

Rejected Frames: number of CCSDS frames rejected by the EOS Service Processor Card.

Uncorrectable Frames: number of CCSDS frames detected with Reed-Solomon uncorrectable
errors by the EOS Reed-Solomon Card.

Deleted Frames: number of CCSDS frames deleted by the EOS Service Processor Card.

Packets with Errors: number of error packets detected by the EOS Service Processor Card.

Deleted Packets: number of packets deleted by the EOS Service Processor Card.

Missing Packets: number of missing packets detected by the EOS Service Processor Card.

6.9 Annotation Status
Note:  The Annotation Processor is ususally viewed after all data has flowed thru the system, and the

"Shutdown" command has been issued.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

3 Hold the mouse button down, move the mouse cursor over Annotation Status, and release the mouse
button to display the following window.
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Fields are defined as follows:

Health: status of hardware during operation; may read Ok, Good, Bad, Dead, or Booting.

General Information: reflects FLIC data processing. Idle indicates card is not processing any data input or
output. Holding indicates telecommand data is input and is currently being processed. Sending indicates data
processing is complete, and data is being output for uplink.

AP State: current activity. Consists of Sleeping (inactive), Halted (suspended by operator), Sessions
(processing a session), Timespan (generating a time-span data set), Purging (purging
obsolete data set files).

Session ID: ID of session currently being processed.

Filename: name of data set (PDS or EDS) currently being processed.

Sources Left:
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Data Count Information

Production Data Sets: number of PDSs generated in this session.

Custom Data Sets: number of custom (time-span) data sets generated in this session.

Quicklook Data Sets: number of quicklook data sets (EDSs) generated in this session.

Rejected Packet Data Sets: number of rejected packet data sets generated in this session.

Rejected Frame Data Sets: number of rejected-frame data sets generated in this session.

Missing Packets: number of missing packets in this session.

Annotation Records: number of annotation records received from the EOS Service Processor and
stored to disk in this session.

Timecode Records: number of timecode records received from the EOS Service Processor and
stored to disk in this session.

6.10 File Transfer Status
The File Transfer status window provides detailed information on number of files transferred by the system.

1 Click on the desired VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on the Status... button within the Quick Status display.

The list of subsystems for the selected VLSI system is displayed.

3 Hold the mouse button down, move the mouse cursor over File Transfer Status, and release the mouse
button to display the following window.
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Fields are defined as follows:

Health: status of hardware during operation. Field may read Ok, Good, Bad, Dead, or Booting.

General Information

Status:

Network Address:

Operation:

Filename: contains name of file to be transmitted.

File Size: contains size of file to be transmitted.

Bytes Transferred:  contains number of bytes in trasmitted file.

Start Time: contains start time of transmission of the file.
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Stop Time: contains end time of transmission of the file.
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ETS TRS Setup & OPERATIONS

7
This section describes system setup, control, and status using the Code 521-
developed ETS TRS operator’s interface.

Procedures for operations via the TPCE interface, a GUI-based user
interface, are detailed in a separate section/document.

7.1 ETS TRS Operational Overview

The ETS TRS is used to playback a pre-recorded stream of serial CADU data at data rates up to 150 Mbps.  This
data stream is output via differential ECL outputs to simulate a TDRS Ground Terminal Return Link to EDOS.
The pre-recorded CADU data can be either simulated data generated by SCTGEN or SCITF generated spacecraft
data dubbed from Ampex tapes.  The simulated data may be in the form of packets or CADUs, and may be
modified by encapsulation into CADUs  and/or injecting pre-specified errors in to the data stream.  To perform
these functions the following set-up procedures and operations have to be followed:

1. Invocation of the TRS Graphical User Interface from the TPCE main menu.

2. Selecting the function to be implemented.

3. Setting up the correct cable connections

4. Setting up the Clock Generator to output the pre-programmed clock frequency and levels.  Implementing the
selected function using the procedural steps outlined in this section.

7.2 Invocation of ETS TRS GUI

Perform the following steps to invoke the ETS TRS GUI window:

1 Click on the VLSI-HRS subsystem icon in the Monitor window.

The Quick Status window is displayed.

2 Click on arrow on the right side of the Utility...  button within the Quick Status display.

The selection for Tape Recorder System is displayed (as shown in Figure 7-1).

3 Click on the Tape Recorder System button.
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Status 
Manual Commands 
Utility  
 
Processing Status:  Ready 
Session Number: 
Orbit Number: 
Ground Station: 
Mission: 
Configuration Set: 
Session Start Time: 
Session Stop Time: 
Pass Start Time: 
Pass Stop Time: 
Last Manual Command Issued: 
Last Manual Command Status:

Tape Recorder System

Figure 7-1. ETS TRS Selection

By default, the Graphical User Interface for the SONY tape recorder will appear (as shown in Figure 7-2).

The TRS GUI layout consists of the following:

The control toolbar: used to control the SONY tape recorder. These functions are rewind, play, fast-
forward, stop, record, and eject.

The macro toolbar: used to invoke the following frequently used functions:

Lock Icon - Lock up the system

DIR  - Show SONY tape directory

Display Icon - Display Event window

AMPEX Icon - Display AMPEX GUI

CSG Icon - Display CSG GUI (to be implemented)

CLR  Icon - Reset SONY
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? Icon - Display Help Window

The event window: used to display a scrollable history of TRS commands

The command input line: used to accept commands to the TRS server.

Exec button icon: used to execute the command.

Figure 7-2. ETS TRS Graphical User Interface

7.3 ETS TRS Modes of Operation

There are two modes of operation for ETS TRS,  namely the Operations Mode, to simulate a return link CADU
data stream at data rates up to 150 Mbps to EDOS via a ‘playback’ from the SONY tape; and the Off-Line Mode,
to ‘dub’ SCITF generated Ampex tapes to SONY tapes, and act as a transfer media for the off-loading, storage,
and staging of CADU test data and data sets.
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7.3.1 ETS TRS Operations Mode - TRS Return Link Simulation

In this mode the Return Link CADU Data Stream is simulated using the ETS TRS playback from the SONY tape
drive.  The SCTGEN created test data i.e. CADU data stream, is previously recorded onto the SONY tape using
the TRS Graphical User Interface.  From the ETS TRS GUI, select Show SONY tape directory to display the
listing of the files on the SONY tape.  The switch panel on the ETS TRS is set as follows:

1. Clock Generator Output to Triplex

2. SONY Data Output to External

3. SONY Clock Output to External

The Clock Signal Generator (CSG) is set manually to the programmed setting for the tape playback.  This would
entail pre-programmed ECL voltage levels of -0.5 High and -0.95 Low, with a duty cycle of 50%, and a rise and
fall delay of 1 nanosecond.  The data rate is user selectable, and the SONY playback is capable of a data rate in
excess of 150 Mbps.   When the software control for the CSG is implemented, the CSG will be set through the
ETS TRS GUI.  The following sequence of steps are followed to initiate a playback:

1. Push SONY Play button icon

Under 'Output To':

2. Select SIO

3. Enter filename

4. Start record (blank for beginning of file)

5. Total records (blank for all of file)

6. Push OK button icon

At this stage the SONY is now playing back data, and the data transfer may be monitored on the ETS TRS GUI.
The playback will terminate once the required number of records have been transferred.  To terminate the
playback at any time:

1. Push SONY stop button icon

7.3.2 ETS TRS Offline Mode - Dubbing From Ampex to Sony

In this mode of operation, the SCITF generated spacecraft data is transferred from the Ampex tape media on
which it is received on to the SONY tape media.  It is from the SONY tape media that the TGT simulation for
Return Link data will be implemented.  From the ETS TRS GUI, macro toolbar, select Display AMPEX GUI, as
shown in Figure 7-3, to access the Ampex menu page.  The Ampex GUI is used to control the Ampex tape drive.
The switch panel on the ETS TRS is set as follows:

1. Clock Generator Output to Ampex

2. Ampex Data Output to Triplex

3. Ampex Clock Output to Triplex
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Figure 7-3. ETS TRS Ampex Menu Panel

The CSG is set manually to the programmed setting of ECL voltage levels of -0.5 High and -0.95 Low, with a
duty cycle of 50% and a rise and fall time of 1 nanosecond.  From the SONY main page the SONY tape drive is
put in to a record mode using the following sequence of steps:

1. Push SONY record button icon

Under 'Record Data From', select Ampex

2. Select Record Mode: Append

3. Enter new filename, record size, total records (blank for no limit)

4. Push OK button

At this stage the SONY is now recording.  Next from the AMPEX GUI main menu page the following sequence of
steps put the Ampex tape drive in to a playback mode:

1. Push AMPEX play button icon
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2. Enter start footage, and duration

3. Push OK button

At this stage the AMPEX is playing back data which is being recorded by the SONY.  Once the dubbing is
complete, the recording is terminated in the following manner:

1. Push SONY stop button icon

2. Push SONY Dir button to verify new file on tape

7.3.3 ETS TRS Offline Mode - Staging SCTGEN Generated 
CADU Test Data

The SCTGEN generated simulated CADU test data is generated on the CDS.  The SONY tape media is selected as
the output device for storing the CADU test data file.  In the case of SCITF generated data, after it has been
'dubbed' from the Ampex tape media, the user may transfer the data on to the CDS to inject errors.  In the case of
SCITF generated packet data, the user may transfer these packet files on to the CDS for encapsulation in to
CADUs by SCTGEN.

7.3.4 ETS TRS Offline Mode - Transferring Data Sets to and 
from the CDS

Since there is a requirement to be able to store a session's worth of data sets, about 26 GB, for simulating a data
set transfer session from ETS to EDOS, the generated data sets have to be stored offline until needed to run the
data set transfer test session.  These Data Sets are created either by SCTGEN or by the LZP capability on the ETS
VHS.  In the former option, the data sets are stored on the CDS local disk as they are generated and transferred
one by one on to the SONY tape media.  In the case of the LZP option, the data sets are generated on the ETS
VHS rack and transferred over selectively by the user.  Once again these data sets are transferred one by one on to
the SONY tape media until needed.

When these data sets are needed, the reverse operation takes place and the data sets are transferred one by one
from the SONY tape media on to the CDS local disk and subsequently FTP'd to the Ciprico Disk Array.

The File Transfer from the CDS to the Ciprico is implemented either by using the command line on the CDS
terminal window, or by using the FTP utility invoked from the Menu Controller.  The following paragraphs
outline the sequence of steps to transfer the data sets to and from the SONY tape media.

7.3.4.1 Transfer From CDS to SONY Tape Media

The transfer of data set files from the CDS to the SONY tape media is via the network.  In this case the transfer is
via Ethernet and the data rate is dictated by the network.  From the ETS TRS GUI, the following sequence of
steps are followed:

1. Push record button icon

2. Enter fully qualified name of data set file on disk

3. Select Record Mode: Append

4. Enter new filename, record size, total records (blank for no limit)
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5. Push OK button

At this stage the SONY is now recording a data set file from the CDS disk on which the file resides on to the
SONY tape media.  This is used to store the created data sets prior to a data set transfer session.  When the data
sets are ready for transfer, they are first transferred to the Ciprico Disk Array and staged for transfer via Ebnet to
their destination.

7.3.4.2 Transfer From SONY Tape Media to CDS

The transfer of data set files from the SONY tape media to the CDS is via the Ethernet  interface.  From the ETS
TRS GUI, the following sequence of steps are followed:

1. Select SIO

2. Enter filename

3. Start record (blank for beginning of file)

4. Total records (blank for all of file)

5. Push OK button icon

At this stage the SONY is now playing a data set file from the SONY tape media on which the file resides on to
the CDS local disk.  This is used as a temporary store for the data sets prior to a data set transfer to the Ciprico
Disk Array.  When all the data sets are transferred to the Ciprico Disk Array, they are ready for the start of a data
set transfer session via Ebnet to their destination.
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Preference Editor

8
The section provides basic instructions on how to examine and
modify preferences for boundaries, default values, etc. of the
control environment’s functions (i.e., the default system to
schedule). Changes made with the preference editor are saved
to a new preferences file and do not take effect automatically.

8.1 Display the Preference

To display  the Preference Editor window, select Preferences... from the Edit menu in the Monitor window.
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8.2 View Preferences
Preferences are divided into groups of related preferences referred to as “categories.” To examine a category’s
preferences, perform the following:

1 Select the desired category from the Categories list (e.g., Data Set Distribution). The list of preferences
appears in the Preferences list.

2 Select a preference to view its description. The preference’s description appears in the Description field.

3 Preference for DataSetDistribution is DataSetDelayTime = 0 000 00:00:10

Preferences for EventLog catagory are as follows:

LogPrintCommand = lpr -s

MaxLogFileSize = 200000

8.3 Modify Preference Value
To modify a preference, perform the following:

1 Select the preference to be modified. The preference’s modification tool appears.

2 Change the preference’s value as desired.

3 Click Validate on the Preferences Value field.

8.4 Save Preference
Modifications to preferences must be saved. Changes are saved to a new preference file that is not used by the
system automatically.
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Click the Save button in the Preference Editor window. Changes are saved and the Preference Editor window is
closed.

8.5 Activate Preference
Changes to preferences are made to a new preference file and are not activated automatically. In order to take
effect, the new preference file must be copied into the proper directory.

Consult a System Administrator about activating changes.
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 Event Log

9
The Event Log contains messages pertaining to ETS HRS
operation. These messages are generated automatically from
the ETS HRS software. The messages can also be generated
manually by operators of the ETS HRS. The information
displayed in the Monitor window’s scrolling list is the current
event log information.

9.1 View Current Event Log
When the event log reaches a maximum predetermined file size, the log is closed and a new event log is created.
The naming convention of event log files is based on the start and end times for opening and closing the event log.
The current event log is contained in the Monitor window (ETS HRS main window).
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9.2 Annotate Current Event
To annotate the current event log with notes or comments, perform the following:

1 Select Add Event Note... from the Edit menu in the Monitor window. The Event Log Annotation
window is displayed.

2 Click on the text area in the Event Log Annotation window.

3 Enter the message text without pressing return. The text automatically wraps to the next line when the
end of the line is reached.

4 Click OK  or Apply  to enter the message in the current event file. When a note is added, the date, time,
and type of message are automatically entered in the event log.

Text Editing Techniques

Pressing the backspace/delete key while typing backs up and deletes characters one at a time. To
delete a block of text, select the text and press the Backspace/Delete key. A block of text may be
replaced by selecting the text to be replaced and entering the new text.

9.3 Turn On Debug Mode
Normally the event log does not display low-level debugging messages. When debug mode is turned on, these
messages are displayed and logged in the current event log file. Normally, the user will not need to turn on debug
mode.

Select Debug On from the View menu in the Monitor  window. Debug messages are displayed and logged in the
current event log file.
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9.4 Turn Off Debug Mode
When debug messages are no longer needed, debug mode should be turned off.

Select Debug Off from the View menu in the Monitor  window. The current event log file stops displaying low-
level debug messages.

9.5 View/Print Old Event Log Files

1 Select Old Event Log Files... from the View menu in the Monitor window.

2 Select the event log file to be viewed from the Log File Selection list. The contents of the file appear in
the scrolling window to the right of the Log File Selection list.

3 Click the Print  button to print the displayed event log.

4 Repeat steps 2 and 3 to view and print other event log files.

5 Click the Close button when finished.
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Data Set Verification
Tool

10
The section provides instructions on how to use the Data Set
Verification Tool (DVT)

DISCREPANCIES WITHIN THE EDOS-EGS ICD

The EDOS-EGS ICD states a file naming convention for a PDS or in section 8.1.2.10.  This consists of 36
characters of PDS/EDS identification plus a 4 character file extension of ".PDS" or ".EDS" for a total of 40 bytes.
This convention applies to the Construction Record (file 0) and all other files of the data set.

The EDOS-EGS ICD defines repeating field 25, in Table 8.1.2.7-1, in the Construction Record, on page 8-19 as
identifying the files that store the PDS/EDS.  Field 25-2, "File Name for a PDS or an EDS," is specified as 40
bytes long but refers to the 36-byte PDS/EDS identification table (Table 8.1.2.8-1), not the file naming convention
table (Table 8.1.2.10-1).  Field 25-1, "Number of files that this PDS/EDS resides in," is described as having a
range of 2 to 255 files.  The file naming convention only allows 100 files.  If the file naming convention is strictly
followed, there is no need to list the full file names in the first file of the data set.  Just the file number could
identify the repeating data fields for a particular file of the data set.

The DVT will expect the 40-byte File Naming Convention (section 8.1.2.10 in the EDOS-EGS ICD), to be
followed for any input data sets. It will also expect the "file names" field (field 25-2 in Table 8.1.2.7-1) in the
Construction Record to be 40-byte file names including the ì.EDSî or ì.PDSî extension.

There has also been some concern over how packets with packet header length discrepancies will be represented
in a valid data set.  The DVT assumes that either the packet data will be padded or truncated or that the packet
length will be adjusted before inclusion into the data set.  The DVT cannot verify this field in the construction
record (Table 8.1.2.7-1 field 10) since it only has access to the final data set.  If the DVT cannot parse through the
data set because the packet lengths do not match the associated data, the DVT could terminate processing or
generate many meaningless error messages.

10.1 Data Set Verification Tool (DVT)
The Data Set Verification Tool (DVT) verifies a subset of the fields of Expedited Data Sets (EDSs) and
Production Data Sets (PDSs) as defined by the Interface Control Document (ICD) Between the Earth Observing
System (EOS) Data and Operations System (EDOS) and the EOS Ground System (EGS) Elements, dated August
9, 1996.  This document is referred to as the EDOS-EGS ICD throughout the rest of this chapter.

Several fields of the construction record (CR), file 0 of a data set, are verified.  Only the fields of the primary and
secondary packet headers are checked for valid values.  Please see the Verification Tests section for an itemized
description of fields and the verification tests performed.  Statistics are gathered by the DVT program as it reads
through the packet headers.  The final step is to compare the DVT information with the CR information.
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10.2 DVT Main Window
The main window for the DVT appears below.  The main window is made up of three sections.  The top portion
allows the user to define the parameters for a verification.  The center section provides statistics for the ongoing or

most recently completed verification.  The bottom portion of the window contains a scrolling message region.

Figure 10-1. DVT Main Window
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10.2.1 File Menu
The File Menu is shown below:

10.2.1.1 Open Report...

Selecting the Open report... option from the file menu causes a file selection box to appear containing DVT report
files that are available for viewing.  After a report file is selected, the file is displayed to the operator using the
editor defined for the current login by the EDITOR  environment variable.  Typically this will be the HP VUE
editor.  If the EDITOR variable is not defined, the ubiquitous UNIX editor vi will be used in its read only version
known as view.  Please refer to the particular editorís on-line help, UNIX man pages or UNIX manuals for help on
editor commands.  The operator should be able to scroll through the report file and copy portions of it to other
files as desired.

10.2.1.2 Print Report...

Selecting the Print report... option from the file menu causes a file selection box of DVT report files to appear.
After a report file is selected, it is sent to the system default printer using the pr command. 

10.2.1.3 Exit

Selecting the Exit option from the file menu causes the DVT to start its shutdown sequence.  If there is a
verification ongoing, the operator will be prompted to terminate it.

10.2.2 DVT Parameters
The top portion of the window displays the parameters for the Data Set Verification Tool.

10.2.2.1 Select... Button

When the user clicks on the Select... button, the following file selection box appears:

Figure 10-2.  DVT File Menu
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The user selects a data set for verification by selecting its construction record.  The construction record is file 0 of
the data set.  The data set selection box uses a filter to display file 0 of all EDSs and PDSs in the default directory.
After a data set is selected, its name appears in the main window.  The DVT report file name is then created from
the data set name and displayed.  After a data set is selected, the Start Verification  button is enabled.

Figure 10-3. Data Set File Selection Box
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10.2.2.2 Maximum Errors

The user may select a maximum number of errors to allow before automatically aborting the verification.  To
increase or decrease the number of errors, the operator may click on the up or down arrowheads next to the field.
Alternately, the operator may position the cursor in the errors text field and type in a number.  The range of values
for the field is 0 to 99999.  If maximum errors is set to zero, there is no limit on the number of errors that can be
found.

10.2.2.3 Start/Stop Verification Button

The Start Verification button is initially disabled.  After a data set is selected, it is enabled.  To start a verification,
click on the Start Verification  button.  The title of the button is changed to Stop Verification and the parameter
fields on the upper portion of the display are dimmed (desensitized).  The operator may choose to stop the
verification at any time by clicking on the Stop Verification button.

The verification stops when the maximum errors are reached, or the verification is completed or the operator uses
the Stop Verification button.  When any of these conditions is reached, the parameter fields on the upper portion
of the screen become sensitized, the name of this button changes to Start Verification , and this button is
desensitized.

10.2.3 Verification Errors
The center section of the DVT main window displays the current counts of verification errors and data set
statistics.  The DVT checks fields of the construction record and packet headers for valid format and range of
values.

10.2.3.1 Format Errors

Some fields in the Construction Record (CR) and packet headers are checked for valid format as specified by the
EDOS-EGS ICD.  These fields have a defined range of valid values.  For many fields, such as those defined as
unsigned integer, it is not possible to have out of range values.

10.2.3.2 Content Errors

Some fields in the CR and the data set packet headers are cross checked for consistency.  For example, the
Construction Record Type field has a value range of 1 to 3.  If this field is 1, indicating a construction record for a
PDS, its format is valid.  But if the file name of the construction record starts with ìEî, the CR Type should
indicate an EDS.  Discrepancies between the file names, CR information and information derived from the data
packet headers are counted as content errors.

10.2.3.3 CR Counts

Information from the construction record is displayed showing the total number of bytes, packets, Source
Sequence Counter (SSC) gaps and APIDs.

10.2.3.4 DVT Counts

The DVT reads the data files and displays its own statistics on number of bytes, packets, SSC gaps and APIDs in
the data set.

10.2.3.5 Bytes Processed

The DVT keeps track of the number of bytes read while processing.

10.2.3.6 % Done
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A rough percentage of the processing done is calculated with the actual bytes processed compared to the total data
set bytes as reported by the construction record.
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10.2.4 Scrolling Message Log

The bottom region of the window is a scrolling message area.  This area of the screen provides confirmation of
operator actions and provides highlights of the ongoing processing.  Any errors encountered with file operations
are reported here.

10.3 DVT Report
The DVT Report contains three types of information.  The first part restates the parameters of the request.  The
next section provides a summary of data set statistics as provided in the construction record and independently
determined by the DVT program.  The last section provides the itemized listing of all errors found and the type of
termination.

10.4 Verification Tests
The DVT performs verification of several fields of the construction record and of the primary and secondary
packet header fields.  The specific format and content tests are summarized in the following two tables.  In
general, the DVT does not perform verification on time fields other than to match time fields from the packet
headers to time fields listed in the construction record.  Time fields are not checked for proper format or time
ordering.  APID and SCID fields are also processed as generic bit string fields.  These fields are used to match
information between the CR and the packet headers, but no attempt is made to verify that APIDs and SCIDs are
valid as defined in the EDOS-EGS ICD or project data base.  There is also no validation of fields related to EDOS
generated fill data.  There are several other fields that cannot be verified by the tool because it does not have
access to the original EDOS processing information.  These fields include CR items 1, 8, 14, 16, 17, 22, 24-6.7,
24-6.9, 24-13, and 24-15.  There is no verification of the data portion of the files, other than that specified for the
packet headers.

Table 10-1. Construction Record Verification Tests

CR Item Name Format Tests Content Tests

1 EDOS Software Version
Number

N/A N/A

2 Construction Record Type Checks range of 1 to 3 Checks that type is
consistent with file name

3 Fill/Spare N/A N/A

4 PDS/EDS Identification Checks for 36 ASCII bytes,
starting with E or P, followed
by 3 fields of APID, followed
by a GMT field, followed by a
numeric byte and ending with
ASCII ì00î

Matched with first 34 bytes
of PDS file names

5 Fill/Spare N/A N/A

6 Test Flag N/A N/A

7 Fill/Spare N/A N/A

8 Number of SCS start and stop
times

N/A N/A

8-1 Fill/Spare N/A N/A
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8-2 SCS start time of time pair Format not checked N/A

8-3 Fill/Spare N/A N/A

8-4 SCS stop time of time pair Format not checked N/A

9 Count of fill data for data set N/A Not Verified

10 Packets that had discrepancies
between packet length and
actual length

N/A N/A

11 CCSDS binary timecode from
first packet in PDS/EDS

Format not checked Matched to time from first
packet in PDS/EDS

12 CCSDS binary timecode from
last packet in PDS/EDS

Format not checked Matched to time from last
packet in PDS/EDS

13 Fill/Spare N/A N/A

14 ESH date and time from first
packet in PDS/EDS

Format not checked N/A

15 Fill/Spare N/A N/A

16 ESH date and time from last
packet in PDS/EDS

Format not checked N/A

17 Packets corrected by R-S
decoding

N/A Not Verified

18 Count of packets in PDS/EDS N/A Compared to toolís count

19 Data Set size in octets N/A Compared to toolís count

20 Number of packets with SSC
discontinuities

N/A Compared to toolís count

21 Fill/Spare N/A N/A

22 Time of Completion of
PDS/EDS

Format not checked N/A

23 Fill/Spare N/A N/A

24 Number of APIDs in PDS/EDS Checks range of 1 to 3 Compared with APIDs in
file name and APIDs found
in packet headers

24-1 Fill/Spare N/A N/A

24-2 APID (SCID and APID) 8 bits SCID 5 bits fill 11 bits
APID

Compared to APID in file
name and found by tool

24-3 Byte offset to first packet with
this APID

N/A Compared to toolís offset of
first packet for APID

24-4 Fill/Spare N/A N/A

24-5 Number of VCIDs for this
APID

Not checked Not verified

24-5.1 Fill/Spare N/A N/A

24-5.2 VCDU-ID (SCID and VCID) Not checked Not verified
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24-6 For this APID Number of
packets with SSC
discontinuities

N/A Compared to toolís count of
SSC discontinuities

24-6.1 For this gap first missing
packet SSC

0 through 16,383 Compared to toolís first
missing SSC

24-6.2 Byte offset to first packet with
same APID after gap

N/A N/A

24-6.3 For this gap, number of
packets SSCs missed within
gap

N/A N/A

24-6.4 For this APID gap, CCSDS
time from packet before gap

Format not checked N/A

24-6.5 For this APID gap, CCSDS
time from packet after gap

Format not checked N/A

24-6.6 Fill/Spare N/A N/A

24-6.7 ESH date and time of packet
before gap

Format not checked N/A

24-6.8 Fill/Spare N/A N/A

24-6.9 ESH date and time of packet
after gap

Format not checked N/A

24-7 For this APID, entries in list of
packets with EDOS generated
fill data

N/A Not verified

24.7.1 For this APID, SSC of packet
containing fill

Format not checked Not verified

24-7.2 For this APID, byte offset to
fill packet

N/A Not verified

24-7.3 For this APID, index to fill
octet for above packet

Format not checked Not verified

24-8 For this APID, Count of octets
of EDOS generated fill data

N/A Not verified

24-9 For this APID, Count of
packets with discrepancies
between packet header length
and actual packet length

N/A N/A

24-9.1 For this APID, SSC of packet
with length discrepancy

Format not checked N/A

24-10 For this APID, CCSDS binary
timecode from the secondary
header of first packet in the
data set

Format not checked Matched with time field of
packet found by tool

24-11 For this APID, CCSDS binary
timecode from the secondary
header of last packet in the

Format not checked Matched with time field of
packet found by tool
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data set

24-12 Fill/Spare N/A N/A

24-13 For this APID, ESH date and
time annotation of first packet
in the data set

Format not checked N/A

24-14 Fill/Spare N/A N/A

24-15 For this APID, ESH date and
time annotation of last packet
in the data set

Format not checked N/A

24-16 For this APID, count of
packets from VCDUs with
errors corrected by R-S
decoding

N/A N/A

24-17 For this APID, count of
packets in the data set

N/A Compared to toolís count

24-18 For this APID, size in octets N/A Compared to toolís count

24-19 Fill/Spare N/A N/A

25 Fill/Spare N/A N/A

25-1 For this PDS/EDS, number of
files that this PDS/EDS resides
in

Checks that number greater
than 1 and less than 100

Compared to toolís counts

25-2 File Name for a PDS/EDS (see
Discrepancies in EDOS-EGS
ICD section)

Checks the 40-byte file naming
convention

Searches for file name with
ì.EDSî or î.PDSî extension
as appropriate

25-3 Fill/Spare N/A N/A

25-4 For this file, number of APIDs Checks that number is between
1 and 3

Compares to APID count by
file by tool

25-4.1 Fill/Spare N/A N/A

25-4.2 For this file, APID (SCID and
APID)

N/A Compares to APID found
by tool and compared to file
name

25-4.3 For this APID, time of first
packet in data set

Format not checked Matches time field of first
packet found by tool for
APID

25-4.4 For this APID, time of last
packet in data set

Format not checked Matches time field of last
packet found by tool for
APID

25-4.5 Fill/Spare N/A N/A

Table 10-2. Primary and Secondary Packet Header Verification Tests

Packet Header Field Format Tests Content Tests

Version Number Must be 3 bits of 0 N/A
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Type Must be 1 bit of 0 N/A

Secondary Header
Flag

Must be 1 bit of 1 N/A

Application Process ID N/A Matched to APIDs listed in construction record and
file name

Sequence Flags N/A N/A

Packet Sequence
Count

N/A Used to check for missing packets

Packet Length N/A Used to calculate offset to next packet header, counted
for bytes of APID data

Time Stamp Format not checked Used to match Time of first or last packet given in CR

Users Flags N/A N/A

N/A (not applicable):  For format checking, this means that all possible values are in the fieldís allowed range as
defined by the EDOS-EGS ICD.  For content checking, this means that the tool can not independently verify
contents of field.

10.5 DVT Environment Variables
For the most part, environment variables should be configured by the system administrator.  The variables used by
DVT are listed here for reference.  If the DVT does not work properly and any of the following environment
variables are undefined, the system administrator should be notified.

10.5.1 DVT_VERIFY_TASK
This variable defines the subtask that performs the verification functions.

10.5.2 DVT_DATA_SET_DIR
This variable defines the default directory for the location of data sets.

10.5.3 DVT_REPORT_DIR
This variable defines the directory for generation of reports.  The file selection boxes for displaying or printing
reports use this directory as the default.

10.5.4 EDITOR
This environment variable can be set to the userís text editor of choice.  This editor is invoked when the Open
Report... option is selected from the File Menu.

10.5.5 LPDEST

This is the device name of the system default printer.  Any reports selected from the Print Report...
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Data Set Comparison
Tool

11
The section provides instructions on how to use the Data Set
Comparison Tool (DCT).

DISCREPANCIES WITHIN THE EDOS-EGS ICD

The EDOS-EGS ICD states a file naming convention for a PDS or EDS in section 8.1.2.10.  This consists of 36
characters of PDS/EDS identification plus a 4 character file extension of ".PDS" or ".EDS" for a total of 40 bytes.
This convention applies to the Construction Record (file 0) and all other files of the data set.

The EDOS-EGS ICD defines repeating field 25, in Table 8.1.2.7-1, in the Construction Record, on page 8-19 as
identifying the files that store the PDS/EDS.  Field 25-2, "File Name for a PDS or an EDS," is specified as 40
bytes long but refers to the 36-byte PDS/EDS identification table (Table 8.1.2.8-1), not the file naming convention
table (Table 8.1.2.10-1).  Field 25-1, "Number of files that this PDS/EDS resides in," is described as having a
range of 2 to 255 files.  The file naming convention only allows 100 files.  If the file naming convention is strictly
followed, there is no need to list the full file names in the first file of the data set.  Just the file number could
identify the repeating data fields for a particular file of the data set.

The DCT will expect the 40 byte File Naming Convention (section 8.1.2.10 in the EDOS-EGS ICD), to be
followed for any input data sets.  It will also expect the "file names" field (field 25-2 in Table 8.1.2.7-1) in the
Construction Record to be 40-byte file names including the ì.EDSî or ì.PDSî extension.

There has also been some concern over how packets with packet header length discrepancies will be represented
in a valid data set.  The DCT assumes that either the packet data will be padded or truncated or that the packet
length will be adjusted before inclusion into the data set.  If the DCT cannot parse through the data set because the
packet lengths do not match the associated data, the DCT could terminate processing or generate many
meaningless error messages.

11.1 Data Set Comparison Tool (DCT)
The Data Set Comparison Tool (DCT) compares a subset of the fields of two Expedited Data Sets (EDSs) or
Production Data Sets (PDSs) as defined by the Interface Control Document (ICD) Between the Earth Observing
System (EOS) Data and Operations System (EDOS) and the EOS Ground System (EGS) Elements, dated August
9, 1996.  This document is referred to as the EDOS-EGS ICD throughout the rest of this chapter.

Several fields of the construction records are compared.  Fields of the primary and secondary packet headers are
also compared.  Please see the Comparison Tests section for an itemized description of fields and the comparison
tests performed.  Statistics are gathered by the DCT program as it reads through the packet headers.
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11.2 DCT Main Window
The main window for the DCT appears below.  The main window is made up of three sections.  The top portion
allows the user to define the parameters for a comparison.  The center section provides statistics for the ongoing or
most recently completed comparison.  The bottom portion of the window contains a scrolling message region.

Figure 11-1. DCT Main Window
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11.2.1 File Menu
The File Menu is shown as follows:

11.2.1.1 Open Report...
Selecting the Open report... option from the file menu causes a file selection box to appear containing DCT report
files that are available for viewing.  After a report file is selected, the file is displayed to the operator using the
editor defined for the current login by the EDITOR  environment variable.  Typically this will be the HP VUE
editor.  If the EDITOR variable is not defined, the ubiquitous UNIX editor vi will be used in its read only version
known as view.  Please refer to the particular editorís on-line help, UNIX man pages or UNIX manuals for help on
editor commands.  The operator should be able to scroll through the report file and copy portions of it to other
files as desired.

11.2.1.2 Print Report...
Selecting the Print report... option from the file menu causes a file selection box of DCT report files to appear.
After a report file is selected, it is sent to the system default printer.

11.2.1.3 Exit
Selecting the Exit option from the file menu causes the DCT to start its shutdown sequence.  If there is a
comparison ongoing, the operator will be prompted to terminate it.

11.2.2 DCT Parameters
The top portion of the window displays the parameters for the Data Set Comparison Tool.

11.2.2.1 Select... Buttons
The user uses the Select... buttons next to the data set name fields to define the data sets to be compared.  When
the user clicks on the Select... button for the Data Set A field, the following file selection box appears:

Figure 11-2. DCT File Menu
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11.2.2.2 Data Set
The user selects a data set for comparison by selecting its construction record.  The construction record is file 0 of
the data set.  The data set selection boxes use a filter to display file 0 of all EDSs and PDSs in the default
directory.  After a data set is selected, its name appears in the main window. The DCT report file name is then
created from the Data Set A name and displayed. The second data set selected is associated with the Data Set B
label.  After two data sets have been selected, the Start Comparison button is enabled.  If the user should
accidently choose the same data set for both fields, the following message is displayed.

Figure 11-3. Select Data Set
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11.2.2.3 Maximum Errors
The user may select a maximum number of errors to allow before automatically aborting the comparison.  To
increase or decrease the number of errors, the operator may click on the up or down arrowheads next to the field.
Alternately, the operator may position the cursor in the errors text field and type in a number.  The range of values
for the field is 0 to 99999.  If maximum errors is set to zero, there is no limit on the number of errors that can be
found.

11.2.2.4 Start/Stop Comparison Button
The Start Comparison button is initially disabled.  After two data sets have been selected, it is enabled.  To start a
comparison, click on the Start Comparison button.  The title of the button is changed to Stop Comparison and
the parameter fields on the upper portion of the display are dimmed (disabled).  The operator may choose to stop a
comparison at any time by clicking on the Stop Comparison button.

The comparison stops when the maximum errors are reached, or the comparison is completed or the operator uses
the Stop Comparison button.  When any of these conditions is reached, the parameter fields on the upper portion
of the screen become sensitized, the name of this button is changed to Start Comparison, and this button is
desensitized

11.2.3Comparison Errors Window
The center section of the DCT main window displays the current counts of comparison errors and data set
statistics.

11.2.3.1 Construction Record Differences
The construction records for the two data sets are compared.  Any differences are counted in this field and
itemized in the report.  Note that there may be differences in the number of files that make up the data sets, even
though the number of packets and total data bytes are the same.

Figure 11-4. Duplicate Selection Query
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11.2.3.2 Packet Header Differences
The DCT reads through the data portion of both data sets in tandem.  Any differences in the packet headers are
counted in this field and itemized in the report.

11.2.3.3 Data Set A Packet Count
This field displays the number of packets from the construction record of Data Set A.

11.2.3.4 Data Set B Packet Count
This field displays the number of packets from the construction record of Data Set B.

11.2.3.5 Data Set A Packets Read
This field displays the number of packets read from Data Set A.

11.2.3.6 Data Set B Packets Read
This field displays the number of packets read from Data Set B.

11.2.3.7 % Compared

A rough percentage of the processing done is calculated with the packets read compared to the packet count for
Data Set A.

11.2.4 Scrolling Message Log
The bottom region of the window is a scrolling message area.  This area of the screen provides confirmation of
operator actions and provides highlights of the ongoing processing.  Any errors encountered with file operations
are reported here.

11.3 DCT Report
The DCT Report contains three types of information.  The first part restates the parameters of the request.  The
next section provides a summary of data set statistics as provided in the construction record and independently
determined by the DCT program.  The last section provides the itemized listing of all errors found and the type of
termination. The comparison stops when the maximum errors are reached, or the comparison is completed or the
operator uses the Stop Comparison button.

The report may be viewed or printed using the Open report... or Print report... options from the File Menu.

11.4 Comparison Tests
The comparison stops when the maximum errors are reached, or the comparison is completed or the operator uses
the Stop Comparison button.  When any of these conditions is reached, the parameter fields on the upper portion
of the screen become sensitized, the name of the button changes to Start Comparison, and the button is
desensitized.

11.5 DCT Environment Variables
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For the most part, environment variables should be configured by the system administrator.  The variables used by
DCT are listed here for reference.  If the DCT does not work properly and any of the following environment
variables are undefined, the system administrator should be notified.

11.5.1 DCT_COMPARE_TASK
This variable defines the subtask that performs the comparison functions.

11.5.2 DCT_DATA_SET_DIR
This variable defines the default directory for the location of data sets.

11.5.3 DCT_REPORT_DIR
This variable defines the directory for generation of reports.  The file selection boxes for displaying or printing
reports use this directory as the default.

11.5.4 EDITOR
This environment variable can be set to the userís text editor of choice.  This editor is invoked when the Open
Report... option is selected from the File Menu.

11.5.5 LPDEST

This is the device name of the system default printer.  Any reports selected from the Print Report... option will be
sent to this
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ACRONYMS AND ABBREVIATIONS

Term Definition
AOS Advanced Orbiting Systems
APID Application Process Identifier
CADU Channel Access Data Unit
CCB Configuration Control Board
CCSDS Consultative Committee for Space Data Systems
CDS Control and Display Subsystem
CLTU Command Link Transmission Unit
CPU Central Processing Unit
CRC Cyclical Redundancy Check
DCN Documentation Change Notice
DMA Direct Memory Access
DRAM Dynamic Random Access Memory
EOC EOS Operation Center
EOS Earth Observing System
EOSDIS EOS Data and Information System
ETS EOSDIS Test System
FEP Front-end Processor
FLIC Forward Link Interface Card
GMH Ground Management Header
GSFC Goddard Space Flight Center
GVCID Global Virtual Channel Identifier
HRTB High-rate Telemetry Backplane
I/O Input/Output
LED Light-emitting Diode
LRS Low-rate System
MCC Master Controller Card
MEDS Modular Environment for Data Systems
Nascom NASA Communications
NCO Numerically Controlled Oscillator
OPMAN Operations Manager
SCID Spacecraft Identifier
SCSI Small Computer System Interface
SMA Subminiature Assembly
SRAM Static Random Access Memory
TCP/IP Transmission Control Protocol/Internet Protocol
TCPE Telemetry Processing Control Environment
VCA Virtual Channel Access
VCDU Virtual Channel Data Unit
VCID Virtual Channel Identifier
VME Versa Module Eurocard
VSB VME Subsystem Bus
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